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Structure Solution and Refinement with Olex2: 
A Guide for Chem435 Students 

Introduction: 
 This guide is intended primarily as a companion to the Chem 432 course.  Some of the 
commands and procedures are unique to the computing environment used in this course.  Olex2 is a 
freely distributed and continually evolving program.  Some features that are available in the class 
environment may change appearance or functionality, or become unavailable in later versions.  The 
purpose of this guide is to make you familiar with the Olex2 GUI and give you confidence to use the 
program on your own and in your own computing environment.  As you become comfortable with the 
GUI and the procedures involved, we encourage you to try different options and experiment with 
different techniques.  However, as a beginner learning the basics of crystal structure solution and 
refinement we suggest you follow this guide closely. 
 

Assumptions: 
1. You are working on datasets provided by the Chem432 instructors. 
2. You are working on the computers available in the IMSERC computer lab (B190).  While you 

will be able to solve and refine structures with Olex2 on other Windows, Linux, and Mac OSX 
systems, we cannot guarantee the GUI interface will be identical.  Download Olex2 from 
www.olex2.org . 
 
 

  

http://www.olex2.org/
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Description of the Solution and Refinement Procedure: 
 

For Rigaku Data 
 
 If data is collected on the Rigaku diffractometers you will end up with a folder named struct that 
contains all the files you need to solve and refine your structure. These include (but not exclusively): 

1. Filename_.ci_od – This cif file contains all the diffractometer and collection settings for 
publication. 

2. Filename.hkl – The data file type used in structure solution and refinement packages.  
Contains only the Miller indices, intensity and errors on intensities for each reflection.  This 
file has been corrected for absorption 

3. Filename.ins – The instruction file for use in SHELX 
4. Filename_red.sum – The file is located outside of the struct directory and has information 

on the data reduction. Not necessary for structure solution but contains useful information. 
5. Filename.grl – The file is located outside of the struct directory too. This contains 

information on how space group was determined. Not necessary for structure solution but 
contains useful information. 
 

 This is not a complete list of files, but represents the ones you will be using the most to solve 
and refine your structures.  

For Bruker Data 
 
 If data was collected on the Bruker diffractometers and integrated by the data processing 
software, you will typically end up with most, if not all, of the following files: 

1. Filename_0m.raw – The raw data file which contains all of the reflection indices, their 
direction cosines, their intensities and errors on the intensities.  Some files will also contain 
header information. 

2. Filename_0m.hkl – The data file type used in structure solution and refinement packages.  
Contains only the Miller indices, intensity and errors on intensities for each reflection.  (Can 
contain direction cosines in some cases).  This file is often generated by the data scaling 
program SADABS. 

3. Filename_0m.p4p – The file that contains most of the experimental data, including the unit 
cell, orientation matrix, chemical formula, morphology information and data collection 
parameters.  It is produced in Apex2 during the data integration phase. 

4. Filename.abs – This is the output file from SADABS and contains information relevant to the 
scaling and absorption correction applied. 

In all cases, the “_0m” suffix indicates the file contains the complete, “merged” data from the 
diffraction experiment and integration.  This is not a complete list of files, but represents the 
ones you will be using the most to solve and refine your structures. 

 
Initially, the only files you will need are the .raw and .p4p files.  These will be read by the 

program XPREP to produce the .hkl and .ins (instructions) files for structure solution.   
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There are several available programs that can be used to solve a structure.  This course will 
focus on the SHELX suite of programs; the structure solution algorithm is called “XS”.  Once you have 
obtained a solution from “XS” you will have a .res (results) and .lst (listing / output) file.  Structure 
refinement is obtained by making changes to the model obtained in your .res file, saving those changes 
as a new .ins file and running the refinement algorithm “XL”.  This cycle is repeated until any change 
increases the R-factor of the refinement.  This procedure is displayed in Figure 1.  The entire process can 
occur within the Olex2 GUI. 

The “XM” and “XT” structure solution packages and XL (ShelXL) refinement package are all 
available to you within Olex2.  With Bruker data you will start with .raw and .p4p files to use XPREP. 
With Rigaku data you will have already done that on the instrument CrysAlisPro  software and will start 
with the third step of the .ins and .hkl files. 
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Figure 1.  Flowchart describing the structure solution and refinement procedure.  This can all occur inside the Olex2 
GUI. 
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The Olex2 GUI 
 Olex2 is not in itself a structure solution and refinement program.  It is a graphical user interface 

(GUI), which combines the programs mentioned above, with a molecular graphics display and several 

other tools which facilitate structure reporting and will be discussed as needed.  The Olex2 GUI is 

divided into four main parts: 

 

1.  The Main GUI Panel:  This panel contains controls for most of the program’s features.  It is 

divided into five sub-panels, accessed through the corresponding tabs at the top of the 

panel. 

a. Home:  This panel contains general information, settings, tutorials and news. 

b. Work:  The work panel contains three further sub-panels – Solve, Refine, and 

Report.  Each of these contains the components necessary for their respective tasks.  

These will be discussed in detail throughout this guide. 

c. View:  This panel contains commands for structure visualization, symmetry 

generation, geometry calculations and other graphical tools. 

d. Tools:  Commands to create images, apply restraints and constraints, display 

chemical information, generate hydrogen atoms, model disorder, create electron 

density maps and structure matching overlays are held here.  Additionally, 

commands to change the global Olex2 settings are provided on this panel. 

e. Info:  Information about the refinement statistics and reflection information are 

found here. 

2. The Graphics Window:  The bulk of the Olex2 interface is taken up by the graphics display.  

In this large window, your structure model will appear in the foreground, and refinement 

 
 
 
 
 
 
 
 
 
 

Main GUI Panel 

 
 
 
 
 
 

                            Graphics Window 

Command Prompt 

File Menu 
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and other information appear as text behind it.  You can toggle the structure and the text on 

and off as you see fit, by pressing Ctrl-T.  In this window you can make many changes to 

your structure by clicking the mouse. 

3. The Command Line:  At the bottom of the graphics window, you will find a “>>” symbol 

which indicates a command line.  While most of the commands you will use in Olex2 can be 

clicked on from the Main GUI Panel, you might find it more efficient to type those same 

commands in at the command line.  Some commands can only be given at the command 

line, so it is useful to know how it works. 

4. The File Menu:  Running along the top of the screen is the file menu.  As with the Main GUI 

Panel, most Olex2 commands can be called from the file menu.  Aside from loading 

structure models from the “File” menu, this is the least efficient way to control Olex2. 

Many of the commands and features of Olex2 have an  icon next to them, which will reveal 

tool tips and helpful information if you click on it! 

The Olex2 GUI is highly color-coded.  Parameters that are shown in bright green are typically 

good, those in dull green or yellow are close to good, and those in red are suspicious and should 

be investigated. 

 

 

Determining the space group  
 
1. Double click on the dc.par file in your directory. Say you want to open it anyway and click ok 

2. Click on the  on the left side of the program the type “Gral Go” 
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3. Once the integration is finished, the GRAL window will pop-up (Like XPREP) and ask you to assign the 

space group. Click “Apply”.  

4. Investigate the centering absences. Recall that the first row corresponds to the total number of 

reflections you would expect to collect for the condition listed in the column. The second row indicates 

how many of the symmetry equivalent reflections that you collected violate that condition. This cell 

appears to be primitive. Click “Apply”. 

5. The Niggli cell test will look for any unit cell transformation matrices that produce a reduced cell.  Click 

“Apply” 

6. Pay close attention to the Rint value, recall that this value should be below 0.10 for good data. A low 

Rint value suggests that your integration strategy and unit cell assignments are correct.  Click “Apply”.  
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7. Now GRAL will search for higher metric symmetry and additional centering conditions. Click “Apply”. 

8. The |E2-1| analysis indicates a center symmetric structure. Look at the “Experimental” column, and 

the |E2-1| value.    Click “Apply” 
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9. Space groups are presented. Click “Apply” 

10. Now GRAL will produce your HKL and .ins files. Click “Finish”. 

 

 

Getting Started in Olex2. 
 

Start Olex2, simply double-click the Icon on the desktop. 

 

1. You now need to read in the instructions file (.ins).  At the Command Prompt, type “reap” or in 

the File Menu, click “File → Open”.  This will pop up an Explorer window.  If not already in your 

working directory browse to your working directory. 

 

2. You should see a list of files, double-click the filename.ins file (just created if using Bruker) to 

load this into Olex2. 
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3. The main gui panel should have changed to give you the “work, view, tools, info” tabs.  Click the 

“Work” tab.  [If the Work tab does not open click another of the tabs and then click back to 

Work.  This is a small bug in the program.] 

 
4. Alternatively if Olex2 is not open, Right-click on the .ins file in a Windows Explorer window and 

choose “Open With Olex2” 

 

Solving a Structure in Olex2 
 

1. Now that you have loaded your filename.ins file into Olex2 click on the Work tab.   
 

2. Press the \/ button to the right of the word Solve.  
 

3. This will bring up the Solve GUI as shown in Figure 2.  Clicking 
any of the grey headers (Solution Settings Extra, Toolbox 
Work, History, etc.) will expand those sections.  Click the 
Solution Settings Extra header now. 
 

4. The top part of the Solve GUI shows you which solution 
program and method you are using, which Reflection (or data) 
file you are using, the Chemical Composition, Z, Z’ and your 
estimated Atomic Volume.  Your space group is also shown. 
 

a. Each of these drop-down boxes contains a list of the 
available solution programs and methods. 

b. For instance, using the XS program, you can change 
“Direct Methods” to “Patterson”.  And you can change 
XS to XM to bring up “Dual Space” methods. 

c. For the purposes of this manual, we will focus on 
using XS with either Direct Methods or Patterson 
methods.  However, you might find that XM/ Space 
method Dual or XT/ intrinsic Phasing works better for 
the type of structures 
you will be solving.  
After you understand 
the workings of the GUI, experiment with different solution algorithms. 

d. Note: ALWAYS check that you are using the SHELX programs (XS, XM, XL) to do your 
work. 

 
5. The Solution Settings Extra frame contains method-specific settings that you can change to 

obtain the correct solution.  For XS/Direct Methods, the most important of these values is “tref”.  
Click the “i” icon next to tref to view information about the command.  For now, type “1000” in 
the np box and press <enter>.  This will change the number of solution attempts to 1000.   If the 
solution you get with 1000 attempts is unreasonable, try increasing this number to 10,000.  
Olex2 will automatically insert the proper commands into your filename.ins file. 

Figure 2.  The Solve GUI upon 
starting a project 
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6. Press Solve at the top of the GUI to start the structure solution program. 

 
7. You will see several lines of text scroll by in the graphics window, and you may see some atoms 

from your structure solution in the window as well.  At the command line, type “lines -1” to 
display all lines of text.  Compress the “Solution Settings” window by clicking the “solution 
Settings header”.  Expand the “Toolbox Work” section by clicking its header.   
 

8. Click the  button to bring all the “atoms” into view.  If this does not work (a small bug), 
right-click in the Graphics Window and drag the mouse down to zoom out (drag up to zoom in). 
 

9. In order to determine if you have successfully solved the structure, first examine the output of 
the solution procedure.  If the atoms in the graphics window are obscuring the text, Press “Ctrl-
T” until the atoms are hidden and only the text is there.  If you have trouble viewing the text 
against the background, press “F4” to change to a solid background.  See Making Pretty Pictures 
for information on how to change the display settings. 
 

10. Examine the text output in the graphics window.  You should see a table with lines such as this: 
Try      Ralpha  Nqual  Sigma-1   M(abs)  CFOM    Seminvariants 

1635773.  0.045 -1.000    0.957   1.256  0.045*   +---- -++-+ +-++- ++-

++  

11.  Look for the values under CFOM (combined figure of merit).  The lower the value, the better 
the solution.  The lowest CFOM value will be marked with a *.  A value less than 0.1 is a good 
sign that your structure is solved.  Though, this is only a rough guideline. 
 

12. At the command prompt type “edit lst” to bring up the listing file output from the solution 
procedure.  This file begins with your instructions and then contains a list of rejected reflections 
(including systematic absence violations), Inconsistent equivalents, results of the solution 
calculations, locations of found atoms, a two-dimensional “connect-the-dots” style electron 
density map, and a table of distances and angles for the found atoms.  Scroll through the file to 
look for these things.  Make a note if there are many systematic absence violations as this may 
indicate problems with your data or your space group choice.   
 

13. Look near the bottom of the file where the CFOM histogram table is (CFOM Range   Frequency).  
This histogram shows you the frequency with which a CFOM was found in a particular range.  
Ideally you will see a large number of “hits” with low CFOM values.   If not, you might not have 
found the correct solution.  It is possible to get a correct solution with a higher CFOM value.  If 
this is the case, you can select that solution by editing your .ins file so the TREF line reads: “TREF 
-1183165” (where 1183165 is the number code of the solution you want, found in the list 
directly above the CFOM histogram).  This number is randomly generated for each machine and 
each structure solution run.  It will not apply if you run a refinement or another solution 
attempt. 
 

14. When you are satisfied with the .lst file, close it and return to Olex2.  Press “Ctrl-T” again until 
your model appears.  Type “Lines 10”at the command prompt if you wish to limit the amount of 
text that is displayed.  (10 is an arbitrary number which you can set to whatever value you like).   
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15. Now it is time to inspect your structure.  If your Q-peaks are not bonded to anything press Ctrl-Q 
to toggle bonds to Q-peaks on.  Rotate the structure by holding the left-mouse button down as 
you drag the mouse across the screen.  Rotate the structure in the plane of the screen by 
holding Ctrl + left mouse button and dragging the mouse.   Zoom the structure by holding the 
right-mouse button and dragging the mouse up and down, or left and right. 
 

16. Any atoms found by the solution program will show up as a colored sphere.  Residual electron 
density peaks “Q-peaks” are shown as a gold sphere.  Figure 3. Shows the default color 
conventions for Olex2.  
 

 
 
 

17. Q-peaks are positions of concentrated electron density in the map.  The “higher” the Q-peak, 
the more electron density at that position.  The highest Q-peaks will represent atoms in your 
structure not assigned during the solution phase (with XS/Direct Methods).  The lower Q-peaks 
may be atoms, or may be background noise.  This is up to you to determine, based on your 
knowledge of the chemistry involved.  XS numbers Q-peaks so the largest peak is Q1.  Press “F3” 
to toggle labels on and off.  The ‘height’ of the peaks is designated by how “opaque” the gold 
sphere is; Figure X shows a Q peak Q1 (at right) that corresponds to a copper atom (Z = 29) to a 
Q peak Q17 (at left) that corresponds to noise. 

Figure 3.  The Olex2 default atom coloring scheme displayed as the Periodic Table.  See Making Pretty Pictures for                                      
information on how to change atom properties. 
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Figure 4 .  The intensity of a Q peak arising from noise (Q17, left) versus a Q peak 
corresponding to a copper atom (Q1, right). 

18. To view information about the height of each Q-peak, type “info $q” at the command prompt.  
Alternatively, simply hover the mouse pointer over a particular Q-peak, and a comment box will 
appear with the peak number and its height.  You can also scroll the mouse wheel up and down, 
or move the “Peaks” slider in the peak and Uiso sliders line to hide or display Q-peaks.   (See the 
“i” icon for information on how the slider works).   

19. Press “Ctrl-Q” or click the  button to toggle between show Q / show Q+bonds / hide Q 
states.  By toggling the bonds on, and/or removing weaker Q-peaks, you should be able to pick 
out discernible features of your structure from the residual electron density peaks.  With the 
bonds on, simply hover over a bond between an atom and a Q-peak to see the bond distance.  If 
nothing appears to make sense you can: 

a. Tweak your solution parameters (or try another method) to get a better solution 
b. Try to name some of the highest Q peaks (described below), refine the structure once 

and hope more sensible atoms “fall out.” 
c. Delete all the Q peaks and refine only the atoms that have been assigned. 

 
20. If it looks as though your structure is only partially displayed, it could be sitting on a symmetry 

element (for instance a centrosymmetric molecule could lie on an inversion center).  At the 
command prompt type “grow”.  This will extend any dangling bonds to atoms that are 
generated by symmetry operations of your space group.  It is important to note that this 
method only generates atoms that are bound to atoms or Q-peaks in your model.  Alternatively, 
your structure may appear to be fragmented, with part of a ligand displaced from the central 
metal atom, perhaps.  If you think this is the case, type “compaq” at the command prompt or 

press  to bring all the Q-peaks and atoms as close together as possible by symmetry 
operations.  See Making Pretty Pictures for other ways to display your structure. 
 

21. If the Q-peaks make some chemical sense based on your model structure, you will need to 
assign them to the appropriate atom types.  Before you start making changes to your model 
Press the /\ button next to the Solve tab to collapse it, and expand the Refine tab, by pressing 
the \/ button next to Refine. 
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Editing the Model and Refining Your Structure 
 

1. In the Refine window you will see a similar list of programs and 
methods as in the Solve window.  Additionally, the Toolbox, 
History, Select, Naming and Sorting menus will all still be present.  
The Toolbox…Sorting menus have the same functionality in Refine 
as they do in Solve.  The programs listed at the top of the window 
are different.  These are the refinement methods.  This course 
will only focus on using the XL refinement program and the 
Least Squares refinement method.  We do not recommend using 
the other methods available with Olex2 for the assignments in 
this class (specifically the final exam)!   
 

2. The Refine GUI also shows the Reflection file used, the Maximum 
Refinement Iterations, the Number of Residual Peaks, and solvent 
masking options.   
 

3. To adjust your model, you will first want to assign any Q-peaks 
that represent atoms in your structure.  There are several ways to do this in Olex2: 

a. Click to select all the Q-peaks you wish to assign to a certain atom type and press the 
button corresponding to that atom type in the Toolbox window. 

b. Click to select all the Q-peaks you wish to assign to a certain atom type an type “name 
atomtype” at the command prompt (e.g. “name C” to name them all carbon). 

c. Click the button of the atom type you wish you assign in the Toolbox window, and then 
click the corresponding Q-peaks in the graphics window.  [This method puts you in the 
Name mode which will be discussed later].  Press “Esc” to exit the Name mode. 

 
4. At this point, it is sufficient to assign all the Q-peaks to their proper atom type.  We will worry 

about numbering atoms later.   
 

5. As you make changes to your model, Olex2 will automatically save your changes.  If you make a 
mistake, try pressing “Ctrl-Z” to go back a step.  Otherwise you might have to correct the 
mistake by hand, or go back to a previous refinement stage under History. 
 

6. Once you have all of your Q-peaks and atoms properly assigned, you will want to refine your 
model.   

a. Make sure the Cycles is set for the number of least squares set to “4”. 

  Make sure Peaks – number of Q-peaks calculated) is set to 20. 
(These are standard values which can be changed to suit your needs.  It is best to start 
with the defaults first.   

b. In Refinement Settings Extra panel, click the check box next to acta to create a CIF file 
during your refinement. You can click on the “i” icon to reveal additional information for 
all these options.   

c. To start the refinement, either click the Refine button at the top of the GUI, type 
“refine” at the command prompt and press <enter> or press “Ctrl-R” to start the 
refinement process. 
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NOTE:  Olex2 automatically deletes Q-peaks before you run your refinement 
 

7. As your refinement progresses, you will see output from SHELXL scroll past in the graphics 
window.  Scan this output and look for the following items: 

a. The wR2 value is the R-factor calculated during the least-squares refinement.  It is a 
measure of the agreement between the calculated structure factors (Fcalc, from your 
model) and the observed structure factors (Fobs, from your hkl file). 

b. The Mean and the Maximum shift/esd are a measure of how much your model is 
moving during the refinement process.  In the initial stages of refinement, these values 
may be relatively large (± 1-5), but as your refinement comes to convergence, this value 
should approach zero.  Once your Maximum shift/esd reaches a value below ±0.01, you 
know your refinement has converged. 

c. If these two values increase or oscillate during the refinement, chances are you have 
done something wrong.  Check your model for any spurious atoms and/or consult an 
expert. 

 
8. Olex2 will now load the coordinates contained in your filename.res file into the graphics 

window.  If you see no gold “Q” peaks, press “Ctrl-Q” until they appear.  If you press “Ctrl-Q” at 
least three times and still see no Q-peaks, check to see if your Peaks is set to 0.  If it is set to zero 
change it to 20 by typing in the box and refine your structure again (step 6d above). 
 

9. Now you need to inspect your results.  This will consist of making adjustments to your model in 
the graphics window, and inspecting your output files for the information they contain. 
 

Assessing your refinement: 
 
You should return to this section several times as you proceed in your refinements.  Some topics 
mentioned here might not apply after the first refinement cycle.  However, it is good practice to return 
to this section once you think you are finished refining the structure to be sure you have not missed 
anything. 
 

1. At the command prompt type “edit lst” to open the listing output from the refinement you just 
ran.  This file begins with a copy of the instructions you used to run the refinement.  As you 
become familiar with the various commands used in the instructions file, it is a good idea to look 
at this section to be sure you are employing the correct commands.  Continue to scan through 
the lst file to look for the following: 

a. Note if there are significant systematic absence violations.  If your refinement proves 
problematic this could be an indication of what is wrong. 

b. If you see a line that says “Cell contents from UNIT instruction and atom list do not 
agree” this means that the formula you entered from when you collected the data does 
not match your model.  Either you are missing atoms in your model or you have too 
many and therefore your UNIT command is incorrect.  Be sure to inspect the table to 
see which is the case.  Check your model in the graphics window to see which is correct. 

c. Scroll to the list of atoms.  This table gives their coordinates (x,y,z) the site occupancy 
factor (sof) and the displacement parameters (Ueq / Uij).  Look at the values for Ueq / 
Uij.  They should be small (on the order of 0.05) but also they should be consistent.  
Make a note of any atoms which have anomalous U values (either too big or too small). 
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d. The table of Principal mean square atomic displacements will suggest to you any atoms 
that might be split (disordered) over two positions and will flag any atoms that are non-
positive definite.  Note any atoms that are flagged in these ways and check them in your 
model to see if they are assigned correctly. 

e. Inspect the Analysis of variance tables for any unusual trends in your data.  These may 
give clues that a refinement that is ill-behaved. 

f. The list of Most Disagreeable Reflections will show you any reflections obscured by the 
beamstop (typically low resolution with Fobs close to 0 and Fcalc very large).  These you 
can OMIT from your refinement by inserting an “OMIT” instruction in your .ins file 
(consult an expert). 

g. Inspect the table of bond distances and angles to see if the values are reasonable for the 
atoms involved.  Check the errors on these values, as well, to get a sense of how precise 
the measurements are. 

h. Finally, check the Q-peaks table.  The “Peak” column will give you the height of each Q 
peak.  Peaks that are very large can indicate missed atoms.  Look for naturally occurring 
breaks in the heights to determine which peaks could be real and which are just 
background noise. 

 
2. Exit from the text editor and return to Olex2. 

 
3. Much of the metric data you read in the lst file can be found in the Olex2 GUI.   

 
4. Hover the pointer over an atom and a comment box will appear with the Atom name, the 

chemical occupancy (as distinct from the site occupancy due to symmetry constraints), and the 
Ueq value.  If the atom is generated by symmetry, the symmetry operators will also be shown. 
To view information about atoms, type “info $atomtype” at the command prompt.   
 

5. Hover the pointer over a bond and a comment box will appear with information about the bond.  
Selecting two atoms (bonded or not) and hovering over one of them will give the distance 
between them.  Selecting three will give the angle and four will give the torsion.  Note: Olex2 
will not give error information in these boxes.  See Obtaining Metric Data for ways to calculate 
bonds and angles with esd’s.  

 
6. To visually inspect the displacement parameters, right-click in the background of the Graphics 

Window and select “Draw Style → Ellipses & Sticks” or type “telp” at the command prompt.  
This will display your atoms as ellipsoids sized according to the length of the Uij vectors (or 
spheres if you are only refining isotropically).   If any of your atoms disproportionately large or 
small you should investigate if they are assigned to the proper atom type. 

a. To change an atom type, click to select the atom and either click the new element type 
in the Toolbox window, type “name atomtype” at the command prompt, or right-click 
on the atom and choose “Type” and then select the appropriate element.  In all of these 
cases you can select more than one atom. 

 
7. At this point, you should continue assigning or deleting atoms until your model makes chemical 

sense.  You may need to run several refinements in order to have all atoms appear in the 
residual electron density map (as Q-peaks).  If you are having trouble finding atoms or your 
refinement “blows up” (wR2 becomes very large and/or the model ceases to make chemical 
sense) you may want to go back to an earlier stage in the refinement.  (See Going back in time 
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for details). 
 

8. Before you refine your structure again, complete the following tasks: 
a. Check the box next to the weighting scheme (says “Weight”, with two numbers next to 

it).  This will then automatically update the weighting scheme as your refinement 
progresses.  The numbers will turn bright green when the suggested weighting scheme 
is no longer different from your actual weighting scheme. 

b. Click on .  Add the following commands to the file above the WGHT card but below 
the L.S. 4 line, each on a separate line: 

i. BOND $H  (If there is a line that reads “BOND” just add the $H.  This will include 
bonds to hydrogen atoms in your CIF file.) 

ii. CONF  (This adds torsion angle information to your lst and CIF files). 

c. If you need to edit your atoms select which ones and Click on . This will bring up 
the atoms in your .ins file and any restraints you have on them. 

 
9. Continue refining your structure and adjusting your model until the following conditions are 

met: 
a. There are no more high Q peaks left in the map.  Be certain to check for solvent or other 

unexpected features of your model.  If the highest Q-peak in your map looks 
suspiciously like it belongs to your molecule, try refining it.  If its displacement 
parameter stays small, then you have found another atom.  If it gets large, then chances 
are it is just noise. 

b. The wR2/R1 and Weight values stop changing. 
c. The Shift/esd either stops changing or becomes very small. 

 
10. The next steps of the refinement procedure can occur in any order.  There is no “best” way to 

follow every time.  Choose the method that works best for you, but realize you might need to go 
back and try a different order.  These steps are: 

a. Refine anisotropically. 
b. Number/label your atoms appropriately. 
c. Add hydrogen atoms. 

 

Anisotropic Refinement 
 

1. Once you have most or all of your atoms located, you will want to refine them anisotropically.  If 
you are working on a structure with all light atoms (Cl or smaller) you can usually refine 
everything anisotropically at once.  If you have one or two heavy atoms, or a very poor quality 
data set, you might want to try refining only a few atoms anisotropically at first. 
Note:  Adding anisotropic refinements increases the number of parameters from 4 per atom 
to 9, thus increasing the amount of time it takes to run a cycle of L.S.  If you have a large 
number of atoms, this can significantly increase your refinement times.   

2. To refine all atoms anisotropically at once, simply click the ellipse button  on the Toolbox 
Work window.  If the box next to “Add H” is checked, a refinement will automatically run.  It is 
best to un-check this box when you are first starting with Olex2. 
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3. To refine only some atoms anisotropically (for instance, the heavier atoms in an organometallic 

structure), simply select those atoms by clicking on them in the Graphics Window and then 
press the ellipse button.  Again, if the box is checked, a refinement will run automatically.  
[Alternatively, select the atoms and then type “anis” at the command line.  This will not run an 
automatic refinement]. 
 

4. Right-click in the background and select Draw Style → Ellipses and sticks or type “telp” at the 
command line, to view this structure as an ellipsoid plot.  Inspect the atoms that you refined 
anisotropically.  Make sure that they did not turn “non-positive definite” (n.p.d.).  You can see 
this if the atom sphere/ellipse is replaced by a triangle. 

a. You can type “edit lst” at the command prompt and scroll past the atom list to the 
“mean square displacements” list.  This will give you information if atoms might be split 
due to disorder, or if they are non-positive definite. 

b. Olex2 will output a list of atoms that could be split. It is a good idea to look at the .lst file 
too.  SHELXL will tell you how many atoms may be split and how many are n.p.d. but it 
won’t tell you which ones. 

c. If you have large thermal ellipsoids you will need to decide if the atoms are assigned 
improperly (did you mistake a Cl for a Br?) or if they should be split due to disorder.  See 
“Disorder” for more information on treating disordered atoms in Olex2.  If you suspect 
you have incorrectly assigned a noise peak as an atom, delete it and see if your 
refinement improves or if the Q-peak re-appears. 

 
5. Ensure that you have no n.p.d. atoms or that you have re-assigned any n.p.d. atoms to the 

proper element type.  If after a few cycles of anisotropic refinements you still have n.p.d. atoms 
and you believe your model to be correct, consult an expert.  You may need to add restraints to 
your refinement. 
 

6. Once your refinement has stabilized again, you can move on to numbering your atoms properly. 
 

Numbering Atoms 
 

1. It is important that your atoms are numbered in a rational manner.  If you are working on a 
series of similar compounds you should try to number them in the same sequence.  If you are 
working on an organic structure with an established numbering scheme, you might want to 
number the atoms in your structure according to those rules.  In any case, you want to number 
atoms of a given type in a sequential order so C1 bonds to C2 which bonds to C3, etc.  It is 
difficult to read bond/angle tables if atoms are numbered all out of order. 
 

2. Keep in mind that the SHELX algorithms are limited to a four-character naming scheme, i.e. 
C001, N1, Cu2A are good; Te15A, C0059 will cause problems.  Also keep in mind that Olex2 will 
allow you to give two atoms the same label, but will automatically re-label one if conflicts are 
present before the refinement runs.  It is wise to double-check your labels before finishing off a 
structure. 
 

3. There are several methods for numbering atoms in Olex2.  Pick the one you feel most 
comfortable using.  To start, make sure your Q peaks are deleted (type “kill $q” at the command 



20 
 

prompt) or hidden (press Ctrl-Q until they disappear) and that only your asymmetric unit is 
displayed (type “fuse” at the command prompt). 
 

4. Method 1:   

a. Expand the “Naming” tab by clicking on it.   
b. In the box labeled “Start” enter the number you would like to give the first atom [this 

could be 1 if you are starting from the beginning, or another number if you are starting 
in the middle of a series.]   

c. If you want to give the atom a suffix enter it in the box labeled “Suffix” [for instance “W” 
to label oxygen atoms of water molecules O1W, O2W, etc.].   

d. In the “Type” box type the element symbol for the atom type you wish to assign (default 
is C for Carbon). 

e. Click the “Name” button to enter “Naming” mode [an orange message box will appear 
at the bottom of the Main GUI Panel]. 

f. Labels will now appear in the Graphics Window and the cursor will change to show the 
next label you will apply when you click on an atom.  Simply click each atom you would 
like to label in order.  The label will turn to black once you click on an atom. 

g. Note:  Olex2 does not remember the last atom number you used for a given element.  
You must keep track of this if you stop labeling and start again.  

h. When you are done labeling one element type, press “ESC” to exit “Naming” mode. 
i. To number the next element type, enter the correct values in “Start”, “Suffix” and 

“Type” and repeat from step “e” above.  Continue this until all atoms are labeled 
appropriately. 

 
5. Method 2:   

a. Select all atoms of a given type you wish to number in the order that you would like 
them numbered.   

b. At the command prompt type “name #” where the # is the number of the first atom 
(doesn’t have to be 1).  This can be useful if you want to number all atoms sequentially 
without regard to element type. 

c. Continue selecting atoms in order and typing “name #” until all atoms are properly 
labeled. 

 
6. Method 3:  To number a single atom, select that atom and type “name atomlabel” where 

“atomlabel” is the exact label you wish to use for the atom, e.g. C1, N2S, Cu5. If you wish to 
rename an atom you can type “name current new” where “current” and “new” are the old atom 
name and the new atom name you wish to use, respectively. 
 

7. Once all your atoms are properly labeled, you should sort them.  Typically we sort by atomic 
mass and label and then by moieties, with the main molecule first, then any counter ions and 
solvent molecules.   Simply sorting by mass and label is often sufficient. 
 

8. The easiest way to sort atoms is to type “sort +ml moiety +s” at the command prompt.  This will 
sort all atoms first by atomic mass and then by atom number; then it will group atoms into 
individual moieties. 

a. Occasionally, Olex2 will sort moieties into a different order than you would prefer. Under sorting 
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you can change the order using   
9. To use the Main GUI Panel, expand the “Sorting” tab by clicking on it.  First click the “Mass & 

Label” button, which will sort the atoms first by atomic mass and then by atom number.  Then 
click the “Z” button with the heaviest atom listed first. The next line choose Moiety by Heaviest 
atom. You can again change the order under “specific order” 
 

10. When you are all done, inspect your atom list either from what is written on the text or by 

clicking on . Run a refinement to have the properly numbered and sorted atom list 
generated in your output (CIF) files. 

 

Adding Hydrogen Atoms 
 

1. Crystallographers rarely refine hydrogen atoms freely.  Instead, they are typically placed in 
calculated positions that “ride” on their parent atoms.  If you are lucky enough to have high 
quality data in which the hydrogen atoms can be located from the residual electron density 
map, you can assign the Q-peaks to hydrogen atoms, as you would any other atom and refine 
them freely (though never anisotropically).  More likely you will simply add your hydrogen 
atoms in calculated positions.  To do this, follow the steps below. 
 

2. Expand the “Naming” tab by clicking on it and ensure the box next to “Automatic Hydrogen 
Naming” is checked.  This is the default state for Olex2 and is quite handy for routine hydrogen 
refinements.  This allows you to change your atom numbers and have the riding hydrogen labels 
change along with them.  If you need to number your hydrogen atoms differently from their 
parent atoms, then un-check this box.  Close the “Naming” tab when you are done. 
 

3. To automatically add hydrogen atoms to all possible atoms:  
a. Simply click the “Add H” button on the Toolbox Work tab.  If the check-box next to this 

is checked, a refinement will automatically run. 
b. Alternatively, type “hadd” at the command prompt.  This will add hydrogen atoms, but 

will not run a refinement afterwards. 
c. After automatically adding hydrogen atoms, inspect your model to be sure the 

appropriate types of hydrogen atoms were applied.  Remember to expand (“grow”) 
your structure if only part of the molecule is represented by the asymmetric unit. 
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4. To automatically add hydrogen atoms to selected atoms: 
a. Select the atoms you wish to add hydrogen atoms to by either clicking to highlight them 

in the graphics window or typing “sel atomnames” where “atomnames” can by specific 
atom names or variables such as $C or a combination of both. 

b. Follow from step 3a above. 
 

5. To add hydrogen atoms manually: 
a. Click the Tools button on the Main GUI Panel and expand the “Hydrogen Atoms” tab, by 

clicking on it. 
 

 
 

b. Click on the appropriate hydrogen type for the hydrogen atoms you wish to add.  In the 
GUI they are grouped by parent atom hybridization (sp2 vs. sp3) and then designated by 
the number of hydrogen atoms to be added.  Clicking on one button will start “HFIX 
Mode” and an orange box will pop up at the bottom of the Main GUI Panel. 

c. The cursor will change to show you the AFIX code (used by SHELX) that will be used to 
spawn the hydrogen atom.  It’s a good idea to learn the AFIX codes for each hydrogen 
atom type. 

d. Click each atom you wish to apply the specific hydrogen type to.  Olex2 will display a 
warning message in the text window if it cannot add the hydrogen you ask it to.   

e. Press “ESC” to get out of HFIX mode.   
f. If you have other types of hydrogen atoms to add, click the button corresponding to the 

next type you want to add and repeat the process from step d above. 
6. If you understand SHELX syntax for AFIX commands, you can select the atoms you wish 

to add a specific hydrogen type to and type “hadd AFIX mn” at the command prompt 
(where mn is the proper AFIX code). 

 
7. Once all the hydrogen atoms are added, inspect your model (type ‘grow’ to expand your 

structure if you need to) to be sure that all hydrogen atoms are assigned properly. 
 

8. If the box on the “Naming” tab for “Automatic Hydrogen Naming” is checked, Olex2 will number 
your hydrogen atoms according to the number of their parent atom as shown below: 
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Figure 5  Note the hydrogen atoms are numbered according to their parent atoms. 

 
9. Refine your structure as you would normally do.  If SHELX encounters a problem with calculating 

hydrogen atom positions, it will delete that hydrogen atom or it will exit abnormally and this 
may cause problems in Olex2.  If you can’t access your History tab, you will need to first edit 
your ins file outside of Olex2 and then re-open it in Olex2.  Look at the refinement text that 
scrolls by in the Olex2 window and find the problematic hydrogen (SHELX will tell you which 
atoms are causing the problem).  Delete the hydrogen atoms along with their AFIX commands 
from the ins file, save the file and re-open it in Olex2.  Run the refinement again.  You may have 
new errors, so you may have to repeat this process several times.  If you get annoyed, delete all 
the hydrogen atoms, and start again.  Or, consult an expert. 

 

Calculating Hydrogen Bonds 
 
If you are interested in hydrogen bonding schemes present in your structure, Olex2 can help you 
determine what possible interactions are present.  To have Olex2 search for hydrogen bonding 
interactions for you, simply type “htab” at the command prompt.  You will see text like this in the 
Graphics Window: 
 

Processing HTAB with max D-A distance 2.9 and minimum angle 120 

HTAB  O2 O4_$1 d=2.863 

HTAB  O4 O9_$2 d=2.874 

HTAB  O5 O7_$3 d=2.859 

HTAB  O7 O1 d=2.862 

HTAB  O8 O9_$4 d=2.894 

HTAB  O9 O8_$5 d=2.894 

HTAB  O10 O5 d=2.798 
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You can change the maximum D-A distance and minimum angle to whatever values you choose.  
The defaults are standard, but programs like PLATON use slightly longer D-A distances and slightly 
smaller minimum angles.  To change the defaults simply enter them at the command prompt by 
typing “htab 3.0 100” to change them to 3.0Å and 100°, respectively. Or use the scroll bar in the 
hydrogen atoms tab. 
 
The lines that Olex2 produces are commands for your ins file.  They will set up a hydrogen bonding 
table which will be appended to your CIF file for inclusion in your final report.  The syntax gives the 
HTAB command, followed by the donor atom, then the acceptor atom (with a symmetry variable 
appended to it if needed, e.g. _$1).  The d=xxx is not part of the command in the ins file, but Olex2 is 
telling you what the D-A distance is. 
 
The HTAB command in Olex2 will also insert the proper commands in your ins file, along with the 
necessary symmetry operators.  The lines added to the ins file after the preceding HTAB command in 
Olex2 look like this: 
 

EQIV $1 -X,0.5+Y,2-Z 

EQIV $2 -X,-0.5+Y,1-Z 

EQIV $3 1+X,+Y,+Z 

EQIV $4 -1-X,0.5+Y,1-Z 

EQIV $5 -1-X,-0.5+Y,1-Z 

. 

. 

. 

HTAB  O2 O4_$1 

HTAB  O4 O9_$2 

HTAB  O5 O7_$3 

HTAB  O7 O1 

HTAB  O8 O9_$4 

HTAB  O9 O8_$5 

HTAB  O10 O5 

 
The “EQIV” commands set up the symmetry operators which need to be applied to generate the 
various acceptor atoms.  For example, the first HTAB command involves O2 as the donor atom and 
O4 from a molecule whose coordinates have been shifted by the symmetry operation –x, ½ + y, 2-z 
(the 21 screw axis). 
 
After adding the HTAB commands and running a cycle of refinements, your lst file will have the 
following table near the end of the file: 
 

Specified hydrogen bonds (with esds except fixed and riding H) 

 

  D-H          H...A        D...A        <(DHA) 

 

  0.82         2.06         2.864(4)     165.0        O2-H2...O4_$1 

  0.82         2.06         2.874(3)     174.9        O4-H4...O9_$2 

  0.82         2.05         2.859(4)     169.0        O5-H5...O7_$3 

  0.82         2.06         2.862(3)     166.8        O7-H7...O1 

  0.82         2.14         2.894(4)     152.8        O8-H8...O9_$4 

  0.82         2.10         2.894(4)     162.1        O9-H9...O8_$5 

  0.82         2.02         2.798(4)     159.1        O10-H10...O5 

 

The corresponding data will also be included in your CIF file. 
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Going Back In Time 
 
If you run into trouble with your refinement and things start to spiral out of control, or if you 
accidentally lose your work, you can often go back to an earlier refinement.  These files are not saved 
discretely as you create them.  However, Olex2 maintains its own history of your work.  If you need to 
return to a previous refinement, simply open the History tab in the Main GUI Panel, which will show you 
a set of bars corresponding to each of your previous refinement cycles.  The purple bar represents your 
initial solution, and the color of each of the other bars represents it’s R-factor (the brighter green, the 
lower the R value).  To get back to an earlier refinement, click the bar that represents that particular 
refinement stage.  You can click through several bars to see the model to decide which one you want to 
choose.  The corresponding R-factor from that stage will be shown at the lower right of the plot.  
However, once you run a refinement all “future” refinement models will be lost.  Use the >> to scroll 
through the refinement list. 

 

 
Figure 6.  The History tab will allow you to revisit an earlier refinement if you find your model has "blown up". 

Clicking on the History Tree tab will show you a tree view of your solutions and refinements, including its 
R-factor and which algorithm (XL, Olex2.refine, etc) was used to generate it. 
 
You can always back-up your files, by editing them (type “edit ins” for instance) and saving them to a 
different file name.  This is a wise practice no matter which GUI you are using to refine your data. 
 
See steps 18 and 19 in Saving different file types below for other ways to save your work. 
 

Obtaining Metric Data 
 

1. To obtain errors on metric data (bonded or not) click the View button and expand the Geometry 
tab by clicking on it.  Click the link for “Refine and save esd info.”  A refinement will run.  Then 
select any two, three, or four atoms and click the link for “Distance and Angles with esd (of 
selection) the corresponding metric data will appear in the text part of the Graphics Window. 

2. Click the notepad icon  at the top of the Main GUI Panel to bring up the Olex2 log.  This will 
contain all of the text output from the current Olex2 session.  You can cut and paste the metric 
data you wish to keep and save it to a new text document for later use. 

 

Finishing Your Refinement 
 
How can you tell when your structure refinement is finished?  What markers should you look for in 
order to call your structure “complete”?  Every crystallographer runs the risk of missing some aspect of 
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the refinement procedure and submitting an incomplete or incorrect structure for publication.  
Following the checklist below before “finishing off” your refinement will help guard against these 
unfortunate errors.  Of course, this list is not foolproof, so until you have your crystallographic feet 
firmly planted under you (and even then it is still a good idea) show your work to an expert for some 
feedback on things you might have missed. 
 
Ask yourself these questions: 
 

1. Is my model complete? 
a. Are there any large Q-peaks still left in the residual electron density map?  If so, could 

they be missed solvent atoms or features of your molecule?  Ideally your “highest peak” 
and “deepest hole” should be small and of similar magnitude.  Remember, these peaks 
are relative.  A peak of 1.0e- that is ~1.4Å away from an atom might indicate a missed 
light atom, whereas a peak of 4.0e- close to a heavy metal could indicate a poor 
absorption correction or other spurious diffraction effects.  You can try refining these Q-
peaks as atoms to see if they improve your model (and make chemical sense!). 

b. Do you have large/elongated displacement parameters?  These might indicate disorder 
that is possible to model.  See Modeling disorder for information on how to do this. 

c. Are any of your atoms non-positive definite (n.p.d.)?  You must look in the lst file for this 
information.  Olex2 does not supply it in the text output.  If you have n.p.d. atoms, be 
sure you have assigned them correctly.  If you are certain they are properly assigned, it 
is best to consult an expert as there are many causes for this problem. 

 
2. Have I applied an absorption correction? 

a. Make sure that you have applied an absorption correction and that your refinement 
improved after doing so.  If you applied a face-indexed correction and the R-factor got 
worse, check to be sure your faces were indexed correctly and that you have the right 
formula.  If you are having difficulty, consult an expert. 

 
3. Has my refinement converged? 

a. Way back in the beginning of this document, we mentioned the Shift/error as something 
to watch for during the cycles of refinement.  When this parameter reaches 0.000 (or 
close to it – 0.001 is acceptable) your refinement has converged and your atoms have 
stopped moving positions.  This does not mean your model is complete!    

b. If the Shift/error does not decrease to zero, look for it during the refinement and note 
which atom(s) are responsible for the shift.  A common cause of a high shift/error is 
hydrogen atoms with AFIX 137.  If this is the case, try changing the offending AFIX 137 to 
AFIX 33 (fixed positions) to see if this helps.  If you cannot isolate the cause of a high 
shift/error, consult an expert. 

 
4. Do I have the proper weighting scheme? 

a. Make sure that you have checked the box to update the WGHT function in the Refine 
panel of the Main GUI Panel.  Make sure that the WGHT function is no longer shifting by 
large amounts (ideally, not at all). 

b. If you have a very large second term for your WGHT function, this could indicate a poor 
absorption correction or twinning.  If you cannot explain this feature by one of those 
two reasons, consult an expert. 
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5. Do I have any Disagreeable Reflections? 
a. Click the Info tab in the Main GUI Panel to bring up the information options.  Click the 

Bad Reflections tab to expand it.  This will give you a list of your Disagreeable 
Reflections.  Olex2 will flag any in red that it feels should be omitted.  In the figure 
below, note the 2 0 0 reflection has a large Error/esd value (18.45).  The Error is 
calculated based on Fc2-Fo2.  Therefore, this is indicating that the observed intensity is 
much lower than it should be (Fcalc is much greater than Fobs).  The low miller indices 
of this reflection suggest it is obscured by the beamstop and should be omitted from the 
refinement.  Simply click the ‘omit’ link to insert an “OMIT” command in your ins file 
[OMIT 2 0 0] which will exclude this reflection from the refinement.   

 
Figure 7.  The Bad Reflections Table from Olex2.  Note the large discrepancy 

between Fobs and Fcalc for the 0 0 2 reflection. 

b. Alternatively, look at the bottom of your lst file for the List of Disagreeable Reflections.  
It should look like this:   
 
 
 
 

Most Disagreeable Reflections (* if suppressed or used for Rfree) 

 

     h   k   l          Fo^2          Fc^2    Error/esd  Fc/Fc(max)  Resolution(A) 

 

     2   0   0          4.82        962.30      18.45       0.258       3.55 

     0   1   1         41.00         11.26       4.52       0.028       5.00 

     1   0   2       1338.12       1020.10       3.62       0.265       4.61 

    -2   0   4       1160.16        901.96       3.30       0.250       2.33 

     4   1   0        160.28        105.99       3.25       0.086       1.69 

    -1   2   4         98.52        146.26       2.79       0.100       1.97 

     1   2   1         33.56         57.62       2.68       0.063       2.50 

     3   2   4        123.45         77.39       2.54       0.073       1.54 

     0   0   2       1384.39       1154.90       2.42       0.282       6.13 

Note the first reflection given ( 2 0 0) has a very small Fo^2 (4.82) and should have a 
large Fc^2 (962.30).  The resolution is quite low (3.55Å).  From this you can tell the 
reflection is likely obscured by the beamstop and should be excluded from the 
refinement.  Edit your ins file to include the line “OMIT 2 0 0” anywhere before the list 
of atoms to exclude this from the refinement.   
 

c. Either method will give you the same list of reflections.  It is up to you which you find 
easier to read (sometimes, it’s best to look at both, since the lst file gives more specific 
information about each reflection). 
 

d. One thing to note when looking at the Disagreeable Reflections is a trend for all Fobs to 
be larger than Fcalc.  (In the case of the Olex2 table, this will appear as a negative value 
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for Fc2-Fo2/esd).  This is often an indication of twinning and should be investigated.  See 
the Twinning section for more information. 

 
e. Alternatively, if all Fobs are smaller than Fcalc, this is a sign that you may have extinction 

issues.  Add an EXTI command to your ins file and complete a refinement cycle.  Check 
the value of EXTI in the lst file.  There it will show the value of EXTI and its esd.  If the 
value is significantly greater than its esd, continue to include this command in your ins 
file.  Otherwise, delete it. 

 
6. If I have a non-centrosymmetric or chiral structure, is my Flack Parameter reasonable? 

a. See the section on Noncentrosymmetric or Chiral Structures to learn what additional 
steps you may need to take when refining such a structure.  

b. If your Flack Parameter or Hooft parameter is somewhere between 0 and 1, you may 
have missed an inversion center in your refinement or have racemic twinning, or you 
may have collected with a radiation wavelength insufficient to determine chirality (e.g. 
using MoKα with only light-atom elements).  Run through the Twinning and/or Missed 
Symmetry sections of this guide for help.  If you still cannot solve your problem, consult 
an expert. 

 
7. Have I included all metric data? 

a. Did you include the BOND $H, CONF, HTAB, and WPDB -2 commands in your .ins file? 
 

8. What are my final R-factors? 
a. There is no “magic R-factor” below which all structures are “good” or “publishable”.  If 

your model is reasonable and you can explain the problems with it, a high R-factor may 
indeed be OK to publish.  Completely incorrect structures have been published with R-
factors as low as 3%!  Use your intuition when judging R-factors.  If your data look great 
(high I/sig, low R-int) and your R-factor is high (>10%) something is probably wrong.  If 
your model makes no sense but your R-factor is low, chances are something is wrong as 
well. 

b. When calling a structure “done” do not focus on getting the lowest R-factor.  Make sure 
your model makes chemical sense; make sure there are no unexplained artifacts in the 
refinement or data; make sure you did not miss symmetry or twinning. 

c. Most researchers focus only on the final R-value of the refinement to judge its quality 
and completeness.  You should now have a better appreciation for at least a few of the 
reasons why the R-factor alone is a poor way to judge the quality of a structure.   
 

 

Making Pretty Pictures 
 

Structure Maniupulation 
 
At some point you will want to manipulate your structure model to display a packing diagram, a fully-
grown structure, or perhaps a few nearby molecules to show close contacts.  To do this, you will be 
working mostly with the Symmetry Generation tab under the View menu.  To follow along with the 
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commands below, start by clicking on the View button and then expand the “Symmetry Generation” tab 
by clicking on it.  You will see three sub-menus 

• Symmetry Tools 

• Growing 

• Packing 

 
Figure 8.  The three sub-menus under the Symmetry Generation tab. 

1. In order to join parts of a structure that may have been disconnected and moved to separate 
parts of the unit cell, click the “Assemble” button.  This can also help situate molecules which 
may be catenated or otherwise interpenetrated.  The “Assemble” button acts the same way as 
typing “Compaq” at the command line.  “Compaq” is somewhat more powerful as it has 
different options.  Type “help Compaq” at the command line to get instructions on the various 
options. 
 

2. If “Assemble” does not situate your molecule(s) the way you would like, you can use the “Move 
Near” button, to move one fragment closer to another.  Simply select the atom to which you 
would like to move the fragment closer.  Click the “Move Near” button to enter the “move” 
mode.  Click on an atom in the fragment that you would like to move.  Press “Esc” to exit the 
mode.   
 

3. Copy Near acts the same as Move Near, but generates a symmetry-related fragment and does 
not delete the first fragment. 
 

4. Click “center on cell” to move all atoms as close to the center of the cell as possible.  This may 
disrupt catenated fragments.  “Largest Part” will move all fragment close to the largest 
fragment. 
 

5. To toggle a set of Basis vectors or the unit cell on and off, simply click “Show Basis” or “Show 
Cell” respectively. 
 

6. If you want to show more atoms than what are contained in your asymmetric unit, you will 
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need to use either the grow or pack commands.  (You can type either of these words at the 
command line, though “pack” tends to give you many more atoms than you may want). 
 

7. To expand a structure which lies on a symmetry element, or a polymeric structure, press “Grow 
All”.  To be more discriminating in what you grow, use the Grow Mode button: 

a. Choose Short and/or VdW (van der Waals) and enter a value for the search radius (the 
default 2.0Å is often too short, so change it to 5Å).  Click the Grow Mode button which 
will generate pink dashed lines showing possible contacts.  Click any of these contacts to 
generate the next molecule over.  Press “Esc” to exit Grow Mode.   

b. To delete a molecule or fragment you do not want, simply double click an atom in it to 
select the whole fragment and press “Delete”. 

c. To delete all “grown” molecules or atoms, click “Fuse” or type “fuse” at the command 
line. 

d. Alternatively, under the Packing menu, move the slider to “Expand Short Contacts 
(Hydrogen bonds)” to generate potential interactions.  Click on the pink dashed bonds 
to produce the symmetry-generated molecule. 

 
8. To generate a packing diagram, choose one of the following: 

a. Use the slider under Pack Radius to generate molecules that lie within a certain radius 
from the center of the structure as it is currently displayed (not necessarily the center of 
the cell or the origin). 

b. Pack to limits allows you to set a box into which you would like to pack molecules.  
Enter values for a, b, and c (min and max) and click “Pack to limits” to generate 
molecules that fall inside that range.  The default values of -0.5 – 0.5 will generate 
molecules that have atoms lying +/- 0.5 unit cell units from the origin.  Change these as 
necessary to create the look you want. 

c. Click the Fill Unit Cell link to generate all atoms which lie inside the unit cell.  You will 
need to click “Complete Fragments” to generate all the bonded atoms which lie outside 
the unit cell.  This method is highly effective! 

d. Again, press or type “fuse” to return to the asymmetric view only. 
 

9. To toggle the background colors: 
a. Press F2 to toggle between solid blue and solid white 
b. Press F4 to toggle between gradient and solid white or blue. 
c. To change the colors of the background, at the command prompt type “grad” and press 

<enter>.  This will pop up a dialog box that will allow you to choose the colors for the 
four corners of the image window.  This may require a restart of Olex2 to take effect.  
Typing “grad –p=filepath” where “filepath” is the path to an image file, will set the 
background to that image (stretched to fit).  This requires a restart to take effect.  To get 
rid of the image, type “grad –p” at the command prompt and press <enter>. 

d. The default color for the background is given by the values below, in case you need to 
get back to it. 
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Figure 9.  The values for the default color in Olex2. 

 
10. To change atom colors: 

a. Under the Home tab, click the Settings tab to expand it. 
b. Click Atom Styles to bring up a graphical periodic table. 
c. Right-click on the element you wish to edit (in the figure below, Fe). 
d. Choose Graphics → Draw style…

 
 

e. This brings up a Materials Property window 
f. Choose “Sphere” to edit the color of the ball or ellipsoid and “Rims” to edit the octant 

lines for an ellipsoid from the drop-down box “Primitive.”   
g. For the Apply To drop-box 

i. Choose “Atom Type” to apply to all atoms everywhere. 
ii. If you wish to change the color of one atom in a specific structure, select the 

appropriate atom from your structure model, follow the instructions above but 
choose “Individual Atom” from the Apply to drop-box. 

iii. If you wish to change all instances of one atom in a structure (say, for a packing 
diagram you wish to change all Fe2 to a different color) see point ii above but 
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choose “Atom Name”. 
h. Click inside the color boxes to bring up a color palette and select the color you wish to 

use. 
i. Once you have made your changes click “OK” to accept them. 

 

 
 

 

 

Labeling atoms and Saving Images 
 
Once you have a structural representation that you would like to save for a presentation or publication, 
you might want to label some or all atoms and you will certainly want to save the image for future use.  
These functions are handled under the Tools menu.  Click the Tools button and then expand the Images 
tab by clicking on it.  The commands below can be accessed from this panel. 

  
Figure 10.  The Images panel, which lets you label atoms and create figures. 

 
11. To label all non-hydrogen atoms, click the link “non-H”. 
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12. To label only certain atoms: 
a. Click to select the atoms you would like to label 
b. Click the link “selected”. 

 
13. To add symmetry information or change the label style, use the drop-down boxes to the right 

(Symm, Style, respectively). 
 

14. The labels will track with their associated atoms as you rotate the structure, however you might 
want to reposition them before saving the image.  To do this hold down the Shift key while left-
clicking on a label to drag it around on the screen.  
 

15. To delete all labels, click the link “DELETE all labels”.  To delete one or more labels, click to select 
(they will turn green) and then press the Delete key.  
 

16. To change the label color, click the link “Choose the label color”.  This will bring up a window in 
which you can click the color panel to change the label color.  There is no way to change the 
colors of only some labels at this point. 
 

17. To edit a label, double click the label you wish to edit and enter the new text in the dialog box 
that appears.  Click “ok” to accept the new text. 

a. To add a subscript or superscript enter \- or \+ respectively before the text you wish to 
be affected.   Likewise to turn sub- or superscripting off, enter \0. 

i. N\-1 = N1 
ii. N\+1 = N1 

iii. (N\-2\0)\+1 = (N2)1 
 

18. To change the label font, in the Bitmap Images submenu click the link for Atom “(System Font)” 
and select the font style, weight and point size you would like.  Click “ok” to accept your 
changes.   

a. There are many other options and ways to change label fonts and colors, which are 
beyond the scope of this manual. 

19. To add a border to your image, use the “Trim” options in the Bitmap Images submenu.  Check 
the box to add the border “trim” and customize it with the Padding and Border (%) options 
(make sure Border % is not 0).  The Color is given by hexadecimal codes which can be found 
here:  http://www.colorpicker.com or found elsewhere on the web. 

 
20. To save the image as it appears in your Graphics Window, at the top of the Images tab, enter a 

name for the figure in the box.  In the Bitmap Images submenu, in the drop-down box next to 
Type, choose the file format you wish to use (png, bmp, or jpg).  Check the box if you would like 
a Transparent (not white) background.  Customize the resolution by using the drop-down boxes 
on the next line.  The default options produce high quality images.  Click the “Go” button to save 
the image.  The file will be saved to your current working directory. 
 

Saving different file types 
 

21. To save your structure model as a .res or .pdb file, at the command prompt type “file 
filename.ext” and press <enter>, where “filename” is the name you’d like to call the file and 

http://www.colorpicker.com/
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“ext” is the extension of the file type you’d like to save. 
a. For instance, to save a packing diagram as a pdb file, generate the packing plot as 

described above and then type “file filename.pdb” at the command prompt. 
b. If you have a disordered structure and want to save each part in its own individual .res 

file, first delete the part you don’t want (see Modeling disorder for instructions on how 
to do this), and then type “file filename.res”.  Use Control-Z to restore the atoms you 
just deleted.  Then, delete the other part and file it as a different file name.  Remember 
to use Control-Z to restore the deleted atoms before continuing with another 
refinement. 

 
22. To save a model to come back to at a later time (as a backup to the History tab for instance or to 

save a tediously generated interaction plot), at the command prompt type “save model 
filename” and press <enter>, where “filename” is the name you’d like to call the file. 

a. e.g. I generated a hydrogen bonding plot which I would like to save for future use.  I 
type “save model hbplot” at the command line and Olex2 writes hbplot.oxm in my 
working directory 

 
23. To return to a previously saved model, at the command prompt type “load model filename” and 

press <enter>, again where “filename” is the name of your model file. 
a. In the previous example, I would type “load model hbplot” to get back to the hydrogen 

bonding plot I had made. 

Creating a CIF File 
 
When you are finished refining your structure you will need to produce a completed CIF 
(Crystallographic Information Format) file which will be submitted for publication.  The IUCr journals 
(Acta Crystallographica) require your entire paper be submitted as a CIF file.  Other journals require the 
CIF file as supporting information.  There are several software programs freely available that can help 
you edit a CIF file for publication in Acta Cryst style.  Olex2 will help prepare your CIF file to some extent, 
though you will still need to do some editing by hand if you wish to submit it as a complete paper. 
 

1. To prepare a CIF file, click on the  button next to the Report button.   
 

2. At times, Olex2 might pop up a warning box that there is conflicting information in its various 
source files.  If that happens, simply click the correct entries, or type in your own user-supplied 
value to continue. Make sure that the filename.cif_od is in your folder. This has all the 
instrument and collection information.
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3. Expand the “Diffraction” tab. 
a. Add any Special Details or Refinement Special 

details in the appropriate boxes.  If you need to 
explain any features of your refinement 
techniques (treatment of disorder, modeling 
hydrogen atoms), Refine Special Details is the 
place to do it. 

 
4. Expand the “Crystal” tab.  

a. If you know it, you can enter the systematic 
name of your compound in the first box.  
Otherwise, leave it with a ? 

b. Olex2 will read in the colour from cif_od file so it 
is not necessary to add it here, even if it is not 
displayed.  If you wish to add more information 
than the standard _exptl_crystal_colour included 
in the pcf you can choose the correct descriptors for each of the three boxes  

i. The first box gives _exptl_crystal_colour_lustre       
ii. The second box give _exptl_crystal_colour_modifier    

iii. The third box give _exptl_crystal_colour_primary 
iv. Olex2 combines the first and third boxes to generate or overwrite the required 

CIF item: _exptl_crystal_colour 
c. The size should be filled in for you, but you can find these values from the pcf file 

(_exptl_crystal_size_min/mid/max) 
d. Choose a shape from the drop-down box to the right of the crystal size.  Olex2 will fill 

this in for you from the value in your cif_od file. 
e. Enter as free-form text the Preparation Details, Crystallization Details and Crystal 

Mounting details if you so choose.  These are not required CIF items for supporting 
information. 

 
5. You may expand the other tabs (Collection, Publication and Reference) if you choose to add 

those particular bits of information to your file.  They are not necessary at this point. 
 

6. Use the Edit Cif Info button to change 
any CIF information that Olex2 wants to 
add to your file.  Items that you entered 
in the above mentioned menus will 
appear in this box.  
 

7. The IUCr now requires all CIF files to contain both refinement and hkl information.  Keep 
HKL/RES as leave as is. 
 

8. If you wish to include information from another CIF file you can use the “add CIF” link at the 
bottom of the Report menu (shown in the figure above). If your cif_od file has a different name 
you might need to rename that to just a .cif file and add that here. 
 

9. Once you have added all your information, press the “Merge Cif” button.  This will stitch 
together the CIF file generated from your refinement, with your pcf file and the other 
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information you provided in the Olex2 GUI.  Note:  If you run another refinement, it will 
overwrite this CIF and you will have to press the “Merge Cif” button again. 
 

10. Olex2 will pop up a text editor with your CIF file in it.  You can scroll through the file to make 
sure the proper values have been included in it.  Leave this file open for now. 
 

11. Back in the Olex2 GUI, click the “Get CheckCif Report” button.  This may take a while, but it will 
generate a CheckCIF report for your file.  Look through it for any errors or alerts and edit your 
CIF file accordingly.  (This will be discussed in detail in class). 

a. Note:  This CheckCIF algorithm may not be as up-to-date as the IUCr CheckCIF function 
available on the web.   

b. To access the IUCr CheckCIF routine open a web browser and navigate to 
http://journals.iucr.org/services/cif/checkcif.html  

c. Browse to your cif file and select the box for Validation of CIF only (no structure factors).  
Click “send CIF for checking”.  NOTE:  The IUCr now requires submission of the 
structure factor CIF (.fcf) file.  It is a good idea to run your .fcf file through CheckCIF, 
too. 

d. Further instructions will be given in class for how to answer alerts and fix common 
problems. 

12. Once your CIF file is complete, you can use it to make Acta Cryst type reports, or use the Olex2 
GUI to customize your own reports.  These procedures will be discussed in class. 

 

  

http://journals.iucr.org/services/cif/checkcif.html
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Advanced Topics 
 
The following topics will be discussed in class if time allows.  The guides below are by no means 
comprehensive, but can serve as a launching point or a reminder.  If you experience any of these 
phenomena, seek help from an expert. 

Noncentrosymmetric or Chiral Structures 
 
Eventually, you will come across a crystal structure that lacks an inversion center, whether it is non-
centrosymmetric or chiral.  It is important to remember that a chiral molecule can never exist in a space 
group with an inversion center or mirror plane. 
If you do have a structure that is non-centrosymmetric or chiral, you will need to pay attention to the 
Flack and/or Hooft parameters.  Both parameters give an estimation of the likelihood that the current 
structural model has the correct handedness, though they are based on different data.  The value of 
each should be 0 for the correct model and 1 for the incorrect model. 
 
The Flack parameter is calculated by XL during the refinements and can be found in the lst file.  It has 
been the standard parameter for assessing chiral structures for many years.  The Hooft parameter is 
based on statistics in the data and is calculated by Olex2 (or in PLATON).  Olex2 outputs the values of 
each parameter at the end of each refinement cycle in the Graphics Window. 
 
If your Flack parameter is closer to 1 than to 0, XL may display a warning that your absolute structure is 
wrong and your model should be inverted.   Olex2 will also display a warning: 
 

Checking absolute structure... 
Hooft y: 1.00(2) 
Flack x: 0.998(15) 
WARNING: Stucture should be inverted (inv -f), unless there is a good reason not to do so. 

 
To invert your structure, type “inv –f” at the command prompt and press <enter>.  This will apply an 
inversion to the coordinates of the atoms in your structure x y z → –x –y –z.  Run another refinement 
cycle and check the values of Hooft and Flack: 
 

Checking absolute structure... 
Hooft y: 0.00(2) 
Flack x: 0.002(15) 
OK 

 
 After inversion, these parameters are much better. 
 
There are times when these parameters fall between 0 and 1 and have large enough esd’s that it is 
impossible to tell which is the correct hand.  There are many reasons for this: 

• Light-atom structures collected with MoKα will have no discernible anomalous 
dispersion and Flack will be meaningless (Hooft might still give some information – this 
is a current topic of debate). 

• Poor data quality will result in poor calculations of each parameter. 

• Structure is really racemic and you have chosen an incorrect space group. 
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• Structure is racemically twinned. 
Investigate these reasons and if you still have trouble, consult an expert. 
 
When you report a noncentrosymmetric or chiral structure, you need to add a line to the CIF file, 
_chemical_absolute_configuration, which indicates how you determined the absolute configuration.  If 
you did this by looking at the Flack parameter, choose “ad” (anomalous dispersion).  If you had a 
reference molecule in the structure (like a known chiral salt) choose “rm”.   If a known stereocenter was 
preserved through the synthetic method, choose “syn”.  If you cannot determine the absolute 
configuration choose “unk” and if it is meaningless (e.g. an achiral molecule) choose “.”.  The 
combination “rmad” is also acceptable. 

 
Twinning 
 
Often crystals that are submitted for data collection are twinned in one of several ways, defined by the 
nature of the twin law relating the separate crystalline domains.  The twin law is the matrix needed to 
transform one domain into the other.  Merohedral twinning occurs when the twin law coincides with a 
symmetry element of the crystal system, but not the point group of the structure.  This leads to an exact 
overlap of reflections from each component and is not readily detectable from the diffraction pattern.  
Merohedral twinning (aside from Racemic twinning) can only occur for crystal systems with more than 
one Laue group:  trigonal, tetragonal, hexagonal and cubic.  Pseudo-merohedral twins have a twin law 
that is of higher metric symmetry than the true crystal class; for example, a monoclinic crystal with a β 
angle near 90° and the a- and c-axes nearly equal.  If the metric symmetry is close enough to emulating 
an orthorhombic cell, the spots from twin domains may exactly overlap and this may not be detectable 
from the diffraction pattern.  If you are having difficulty refining a structure that is a candidate for either 
Merohedral or Pseudo-Merohedral twinning, consult an expert for how to proceed. 
 
In a more common form of “twinning” – which is not true twinning, but rather crystal intergrowth or just 
“bad” crystals – the resultant diffraction patterns from each twin domain do not exactly overlap.  These 
cases are typically easy to spot from the diffraction pattern and a twin law can readily be determined.   
 
The instrument software is used to determine the twin law and therefore the orientation matrices of 
each twin domain.  After the data are reduced it  produces an HKLF4 (standard) format file to use to 
solve the structure and an HKLF5 (twin) format file, which contains the reflection data from each 
component.  Once you have solved the structure with the HKLF4 file, you can refine against the HKLF5 
data and determine the contribution of each component. 
 
Assuming you have been provided with HKLF4 and HKLF5 files, follow the steps below: 
 

1. Use the HKLF4 file to determine the space group and solve the structure as you would normally 
do. 
 

2. Once you have a good structural model (not necessarily complete, but at least stable) you can 
begin to refine against the HKLF5 file. 
 

3. In the Refine panel, use the drop down box to select the HKLF5-format file for the “Reflection 
File.”   
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4. Edit your ins file with   to add “BASF 0.4” on a line somewhere above the atom list.  This 
sets the “BAtch Scale Factor” to 40%, indicating each the second component contributes 40%.  
This number will be refined during the least-squares cycles. 
 

5. Scroll to the bottom of the ins file, and change the line “HKLF 4” to read “HKLF 5”.  This instructs 
XL to use the “batch number” at the end of each HKL I sig(I) line to determine which component 
the given reflection belongs to.   
 

6. Continue to refine the structure as you normally would.  Check in the lst file for the value of 
BASF and its esd which you will need to report in your CIF file. 
 

7. In this case, TWINABS applies the multi-scan absorption correction, so you will need to edit 
those values in your CIF file.  The Tmin and Tmax can be found in the *.abs file. 
 

8. You should also include some text in your refinement_details section to describe the twinning.  
The final twin law can be found near the bottom of the  _0m._ls file, and the Cell Now output 
file *._cn will have the rotation operation (e.g. 179° around the direct/reciprocal 0.000 0.000 
1.000 axis). 
 

9. You might find that there is little improvement to using the HKLF5 data.  It is acceptable to use 
only the HKLF4 file if you have enough data, but you still need to comment in your CIF file that 
the crystal was twinned. 

 

Modeling disorder 
 
Chances are during your lifetime you will encounter one or more structures that exhibit disorder.  Most 
disorder problems can be diagnosed by looking at the size and/or shape of the displacement parameters 
or by finding higher-than-noise Q-peaks which make unreasonable interactions.  SHELX programs and 
Olex2 will warn you if atoms appear to be split, which is a good sign you should be looking for disorder.  
Typical disorder occurs around freely rotating bonds (e.g. long alkyl chains or terminal CF3 groups) or in 
solvent channels that are larger than the solvent molecules accommodating them.  Some disorder is 
merely occupational disorder – two metal cations split over the same site, a partially occupied solvent 
molecule – and other disorder is both occupational and positional.  We will deal with each briefly below. 
 

Occupational Disorder 
 
Take for example the compound UYb2O2Se3.  In this structure the U and one Yb occupy the same site in 
the crystal structure (0 0 z).  This would become apparent as the displacement parameter for the atom 
on that site would be poorly behaved.  With U fully occupying the site, the Uij of the site would become 
too large; with Yb fully occupying the site, it would become too small.  Clearly something is not right. 
 
An investigation of the geometry of the site and the chemistry involved, would lead to a conclusion that 
the site is partially occupied by both U and Yb in such a way that the charges of the system should 
balance.  In this case, the site must be half occupied by U and half by Yb for the charges to balance.   
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Once the atom site is located, the task is to split the site between U and Yb so that they both have the 
same coordinates and the same displacement parameter. 
 
The atom list in the ins file would look like this: 

L.S. 4 

. 

. 

. 

EADP U1 Yb1 

EXYZ U1 Yb1 

 

WGHT    0.033200 

FVAR       0.21729 

U1    4    0.000000    0.000000    0.307839    10.06250    0.00548    0.00548 = 

         0.01240    0.00000    0.00000    0.00000 

YB1   3    0.000000    0.000000    0.307839    10.06250    0.00548    0.00548 = 

         0.01240    0.00000    0.00000    0.00000 

 
The EADP and EXYZ commands tell SHELX to constrain the displacement parameters (EADP) and 
coordinates (EXYZ) to be equal.  You can see in the atom list that indeed the coordinates and 
displacement parameters are identical.  (EADP works for isotropic displacement parameters, but both 
atoms must be refined in the same manner). 
 
The International Tables gives the multiplicity of the 0 0 z site in this space group (I4/mmm) as 4, which, 
given the 32 general positions, leaves the site occupancy at 1/8th for the 0 0 z site (4 ÷ 32 = 1/8).   For the 
charges to balance the site must be split equally between the two atoms, so the s.o.f. field for each 
atom is set to 10.06250 (1/2 × 1/8 = 1/16 = 0.0625). 
 
Now let’s consider the case where the occupancy is not dependent on charge balance.  It is possible to 
refine the occupancy of a site by tying it to a free variable (FVAR).  In this case, the example above would 
look like this: 
 

L.S. 4 

. 

. 

. 

EADP U1 Yb1 

EXYZ U1 Yb1 

 

WGHT    0.033200 

FVAR       0.21729 0.50 

U1    4    0.000000    0.000000    0.307839    20.12500    0.00548    0.00548 = 

         0.01240    0.00000    0.00000    0.00000 

YB1   3    0.000000    0.000000    0.307839   -20.12500    0.00548    0.00548 = 

         0.01240    0.00000    0.00000    0.00000 

 
Look at the underlined values.  You should notice a second value on the FVAR line.  This is FVAR(2) and is 
used to refine the occupancies.  To start, we have given it a value of 0.5 (50%).   Now look at the s.o.f. 
values for U1 and Yb1.  These have changed from 10.06250 to 20.12500 and -20.12500.  The “2” refers 
to FVAR(2) and the “-2” refers to 1-FVAR(2).  The “0.12500” is the occupancy/multiplicity of the site if it 
were fully occupied (1/8th).  The s.o.f. for U1 is thus given by FVAR(2) × 0.12500; for Yb1 it is (1-FVAR(2)) 
× 0.125000.  Simple algebra shows that the total site occupancy will equal 0.12500 (as it should for a 
fully-occupied site). 
 
After a cycle of refinement there will be an esd associated with FVAR(2) which can be found in the lst file 
under the atom list (s.o.f.) section: 
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ATOM           x         y         z          sof         U11       U22       U33       U23        

 

 U1          0.00000   0.00000   0.30784     0.06352     0.00548   0.00548   0.01240   0.00000    

   0.00122   0.00000   0.00000   0.00006     0.00027     0.00073   0.00073   0.00092   0.00000    

 

 Yb1         0.00000   0.00000   0.30784     0.06148     0.00548   0.00548   0.01240   0.00000    

   0.00122   0.00000   0.00000   0.00006     0.00027     0.00073   0.00073   0.00092   0.00000    

 
The first line for each atom gives the values of the various parameters.  The second line gives the esd’s 
for those values.  Notice in the sof line, how the occupancies have drifted away from an exact 50/50 
split.  However, the errors show they are still within that range. 
 
Note:  Crystallography should not be used as a form of elemental analysis.  The correlation between 
displacement parameter size and site occupancy makes this an unreliable technique for such a 
determination.  It is best to have additional evidence to support the s.o.f. values you determine from 
the diffraction experiment than to use those values to support other claims. 
 
In modeling occupational disorder 

1. Select the atom that will be a shared site 
2. Type exyz in the command prompt 

3. The atom will look something like this  Olex2 will mark atom sites that are occupied by 
more than one atom with an EXYZ band around the atom sphere or ellipsoid.  
 

4. This will add the EADP and EXYZ constraints to keep the atoms positioned on the exact same 
site. 

5. Edit the sof value either to set it manually to a known value (as in the first case) or to a free 

variable to be refined (as in the second case) by highlighting the atom and pressing the   
 

6. Refine the structure as usual, paying close attention to the size of the displacement parameters 
as well as the sof if you are refining it. 

 

Positional Disorder (GUI method) 
 
Olex2 has many powerful tools for working with positional disorder, including the ability to move atoms 
anywhere in the crystal structure.  Obviously, these tools can cause serious issues if not used properly.  
Take care when you perform the following actions and remember that you can always go back through 
your history to return to a better state.  
 
Let us take an example of a disordered C-C single bond (THPP demo structure in Olex2).  The disorder 
becomes apparent when we see the highest Q-peaks in the map correspond to a different orientation of 
the C-C bond.  To model this disorder, we will use the disorder tools available in the Toolbox Work 
panel. 
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1. Before you begin, it is easier to work with disorder if you 

have already labeled the atoms in your molecule 
appropriately. 
 

2. Delete any hydrogen atoms that are riding on disordered 
atoms.  You will generate them again later, but it is easier to 
get them out of the way while you are working. 
 

3. Click to select the atoms you wish to split.  
 

4. 
While these are highlighted, click “Select atom(s) and then” and 
select “split”.  mSplit will put you in the split mode and Split 
Same will put restraints on similar bonds. 

 
5. This will create a second set of atoms directly overlaid on the 

first set, but colored green.  Your original atoms well be colored 
purple. 
 

6. Click on a part of the second set of atoms and drag with the 
mouse to position it in the place you would like (in this case, 
over the Q-peaks).  Use shift-click to drag the selection in the 
plane of the screen, and Ctrl-click to rotate in the plane of the screen.   
 

7. When you have the atoms positioned where you would like 
them, press Esc. to exit the Split Mode.  You will now have two 
separate parts that correspond to each disordered component. 
 

8. If you exit the Split Mode and decide you don’t like the positions 
of the atoms, click to select them again and choose “fit “ byt the 
“Select atom(s) and then” option.  Move the atoms again and 
press Escape to exit the mode.  (This feature works for any atom 
you wish to select and move – USE WITH CAUTION!) 
 

9. Olex2, names the split atoms according to their “parent atoms” 
and automatically inserts the proper commands into your ins file. 

a. The original atoms C2A and C3A give rise to the split 
atoms C2B and C3B. 

 
10. The PART N command tells XL which atoms belong to which disordered components in order to 

prevent “bonds” appearing in the connectivity list to atoms in different components.  Typically 
the major component will be given in PART 1 (e.g. C2A, C3A) and the minor component in PART 
2 (e.g. C2B, C3B). 
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11. The sof’s will need to be refined, and Olex2 will add the appropriate FVAR entries, as well as edit 
the sof’s for the affected atoms. 
 
FVAR 0.37389 0.75 

. 

. 

. 

PART 1 

C2A   1     0.30834  1.20187  0.71223  21.00000  0.02599  

C3A   1     0.36402  1.13434  0.82049  21.00000  0.02599  

PART 0 

PART 2 

C2b   1     0.41321  1.19320  0.73033 -21.00000  0.05000  

C3b   1     0.27572  1.13932  0.81497 -21.00000  0.05000 

PART 0 

  
 Olex2 has set the FVAR(2) value to 0.75, making the assumption that the disorder is skewed 

away from a 50/50 split.  This is reasonable, since the residual electron density was not on the 
order of even half a carbon atom. 

 
12. Olex2 will keep track of the number of different FVAR’s needed if you add another set of 

disordered atoms whose occupancies are tied to each other, but not necessarily tied to the first 
set of disordered atoms.  You can edit the values that Olex2 uses if you wish to tie them all 
together, or if you wish to change the starting value of FVAR(n). 
 

13. Refine the structure through once.  Then, add hydrogen atoms as you normally would.  Olex2 
will handle assigning them to the appropriate PARTs and the appropriate sof variables. 

a. Olex2 will also split riding hydrogen atoms on adjacent (non-disordered) atoms to 
correspond to the correct orientation for each disordered component.  (You will have to 
delete any existing hydrogen atoms and re-add them. 

 
14. Again, pay attention to displacement parameters and values for any FVAR that you set.  And 

judge the disordered model accordingly. 
 

15. It is possible that you will discover disorder by the shape of anisotropic displacement 
parameters, not by the position of residual electron density peaks.  You can follow the steps 
above, moving the split atoms to a site you feel is appropriate.  If after one or two refinement 
cycles, the disordered atoms drift away or into nonsensical positions (or have very low values for 
sof and/or high values for Uij, chances are that the disorder model is not correct. 
 

Positional Disorder (Text-only version) 
 
Olex2 and SHELXL will notify you of atoms it believes to be split over two positions.  Olex2 will show the 
affected atoms as output in the Graphics Window after every refinement cycle.  These atoms are also 
listed in the lst file after the list of refined atom positions.  (Search the lst file for the words “may be 
split” to go right to that section).  The lst file lists each atom that may be split, along with the sets of 
coordinates corresponding to each position.   
 

1. To set up disorder using this list, open the lst file to this list and keep it open in a text window.  
You will be copying the coordinates from this file. 
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2. Open your ins file and scroll to the affected atoms.   
 

3. It is best to start modeling this disorder with isotropic displacement parameters, so delete the 
anisotropic displacement parameters for each affected atom. 

a. Your atom line should have the atom label, the SFAC value, x, y, z, sof, and Uij values 
only (7 entries). 

b. Change the Uij value to 0.05 if it is any larger than that. 
 

4. Copy the lines for each affected atom and paste them in below.  You can either do this in blocks 
if you have a long string of disordered atoms, or one-by-one.  Be sure to change the atom names 
for those in PART 2.  (e.g. C3 to C3A). 
 

5. Place a PART 1 command on a separate line above each atom or block of atoms that belong to 
one component.  Place a PART 0 on a separate line at the end of the block. 
 

6. Likewise, set up the PART 2 commands surrounding the atoms of the second component. 
 

7. Find each affect atom’s split coordinates in the lst file.  Copy the first set of coordinates to the 
corresponding atom in PART 1.  Copy the second set of coordinates to the corresponding atom 
in PART 2.  Repeat this for each affected atom. 
 

8. Edit the sof values for each component (21.000 and -21.000) accordingly and remember to set a 
new variable on the FVAR line. 
 

9. Your ins file should be set up similar to the example above. 
 

10. NOTE:  This method will not always split atoms according to their components (i.e. the first set 
of coordinates for each atom might not all correspond to PART 1).  You should check the 
model after the first refinement to be sure the atoms are assigned to the proper components.  
If you need to move an atom from one component to the other, simply swap coordinates (for 
instance C3 at x y z and C3A at x’ y’ z’, switch the coordinates so C3 is at x’, y’, z’ and C3A is at x, 
y, z). 
 

11. If your model is stable after a few refinements, continue on by refining anisotropically and 
adding hydrogen atoms.  Olex2 will set up the proper PARTs and sof’s for any hydrogen atoms it 
adds. 
 

12. You can combine aspects of both the GUI and text-only methods as you see fit.  If you want to 
let Olex2 split atoms for you, you can use it to set up the ins file, but then edit the coordinates 
by hand from the lst file. 
 

13. There are many ways to finesse disorder models both by editing files by hand, and by using 
Olex2 to shift atoms graphically.  As you work with disordered structures, you will find the best 
ways that work for you and your structures. 
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Viewing Disordered Structures and Other Tools 

You can view the 
different parts of the disorder by clicking on the 0|1 for the parts that have not been split and part 1. 
This will highlight part 1. Escape will get you out of it. Atoms which are not disordered (assigned to a 
PART) are automatically in PART 0.  The various links will display ordered atoms + PART 1 (0 1), ordered 
atoms + PART 2 (0 2), disordered PART 1 + PART 2 (1 2), PART 1 alone (1), PART 2 alone (2), and all atoms 
(ALL), respectively. 
 
 In the Olex2 GUI, click on the Tools tab to switch to the Tools menu.  Expand the “Disorder” window by 
clicking on it.  There are many functions available here for dealing with Disorder.  You can select groups 
of atoms and link their occupancies and/or parts.  You can assign atoms to specific parts.  Perform these 
tasks by clicking on the appropriate links.  As always, check your ins files to be sure the commands have 
executed properly. 
 
You can reference atoms of each PART N on the command line by using “part n”.  For example, if you 
wish to select all the atoms of PART 2, at the command prompt type “sel part 2” and those atoms will be 
highlighted.  If you want to just see different parts you can use the command “showp M N” where M 
and N are different parts. 
 

External Resources 
 
Olex2 is a powerful GUI for structure solution and refinement.  This manual only briefly touches on many 
of the features you can use to solve, refine, model and display your structures.  Over time you will 
discover many tricks and shortcuts not presented here.  There are many excellent resources for help 
with Olex2.   
Click on the “home” button to return to the Olex2 home screen.  There are tutorials you can try, a 
searchable command manual, and the Olex2 website. 
The crystallographic community is small and generally friendly.  Old-timers are usually willing to help out 
new-comers with even the most basic questions.  Often throughout this guide you find the words 
“consult an expert.”  This is a mantra that will serve you well as you work through your structures.  
Crystallography (as with most science) is not done in a vacuum, unless you are doing ultra-low pressure 
work, I suppose.  Seek out advice from your advisers, staff crystallographers or internet forums.  You will 
most assuredly find someone who can get you the help you need. 
 
Good luck, and happy solving! 

 


